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SAŽETAK 

Ovaj diplomski rad pod naslovom Hibridna animacija obuhvaća praktični dio koji se sastoji 
od sinopsisa, knjige snimanja i šest animiranih kadrova koji su nastali primjenom tehnika te 
teorijskog dijela koji pojašnjava navedene tehnike. Svrha je ovoga rada istraživanje tehnika i 
mogućnosti hibridne animacije, te proučavanje prednosti i ograničenja takvog oblika 
animacije. 

U teorijskom dijelu ovog diplomskog rada bit će objašnjeni temeljni pojmovi povezani s 
hibridnom animacijom te dani primjeri takve vrste animacije. Zatim će biti opisan proces 
izrade jednog od mnogih oblika hibridne animacije u kojem će biti objašnjeno kako postići 
rezultate koji su vidljivi u praktičnom dijelu. Teorijski dio sastoji se i od rječnika koji ukratko 
objašnjava pojmove upotrijebljene u ovom radu. Svrha teorijskog dijela ovoga rada jest 
predstaviti detaljan pregled procesa izrade hibridne animacije koji može služiti kao 
referencija ili vodič za izradu. 

Na kraju rada nalazi se analiza procesa u kojoj su opisane prednosti i mane upotrebe ove vrste 
animacije te osvrt autorice na rezultate istraživanja. 

Ključne riječi: hibridna animacija, 2D animacija, 3D animacija, 3D modeliranje 

 

ABSTRACT 

The purpose of this graduate degree paper is to research the techniques and possibilities of 
hybrid animation and to look at the advantages and drawbacks of this type of animation. The 
paper consists of a practical and a theoretical part. 

The practical part of the paper includes a synopsis, a storyboard, and six animated shots made 
by applying the techniques outlined in the theoretical part of this paper. 

The basic terms related to hybrid animation and some examples are given at the beginning of 
the theoretical part. Next, the process of creating one of the many forms of hybrid animation 
is described, detailing also how the results presented in the practical part of the paper were 
achieved. The theoretical part also includes a glossary of the most important terms found in 
this paper, with short explanations. The purpose of the theoretical part of is to give a 
comprehensive overview of the hybrid animation creation process, and this can later be used 
for reference or as a guide for animators. 

An analysis of the described process detailing the advantages and disadvantages of this type 
of animation can be found at the end of the paper, with the author’s review of the research 
results. 

Keywords: hybrid animation, 2D animation, 3D animation, 3D modelling 
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1. UVOD 

Razvoj tehnologije donio je sa sobom nove tehnike animacije i dao umjetnicima novi alat za 
ostvarivanje njihove kreativne vizije. S novim tehnikama pojavile su se nove vrste animacije, 
a tako i hibridni oblici koji kombiniraju dvije ili više vrsta animacije. Mogućnosti 
kombiniranja animacijskih tehnika bezbrojne su i otvaraju vrata za nova kreativna rješenja. 
Naravno, hibridna animacija ima svoje prednosti i mane, što je jedan od razloga zbog kojih 
sam odlučila posvetiti svoj diplomski rad istraživanju te vrste animacije. 

Postoji mnogo različitih vrsta hibridne animacije, a jedna je od njih kombiniranje 2D i 3D 
animacije. Vjerujem da tehnike i mogućnosti hibridne animacije imaju velik potencijal i 
mogu služiti kao koristan alat u ostvarenju kreativne vizije umjetnika. Zbog toga ovaj 
diplomski rad posvećujem istraživanju mogućnosti jednog oblika hibridne animacije. Tehnike 
opisane u ovom tekstu pomogle su ostvariti rezultate koje sam željela u svojem radu. Nadam 
se da će ovaj rad pomoći i drugima da postignu željene rezultate. 

U ovom diplomskom radu bit će prikazano istraživanje jednog oblika takve animacije. 
Literature koja objašnjava proces izrade hibridne animacije vrlo je malo, a sama je tema vrlo 
opširna. Iako su neki dijelovi procesa bili opisani u raznoj literaturi, velik dio izrade ovoga 
rada sastojao se od eksperimentiranja i ispitivanja raznih tehnika. Mnogi su pokušaji bili 
neuspješni ili su rezultirali nekvalitetnim rješenjima. Naglasak ovog rada su tehnike koje su 
dale željene rezultate. 

Započet ću definiranjem hibridne animacije i prikazat ću neke od primjera različitih oblika 
ove vrste animacije. Zatim ću opisati svoj proces izrade hibridne animacije, počevši od 
pripreme za animaciju koja se sastoji od sinopsisa, model-liste i knjige snimanja. Nakon toga 
slijedi opis izrade animacije koja se sastoji od izrade 3D scenografije, 3D skice, 2D 
animacije, postavljanja 3D materijala na 2D crtež i kompozitinga. 

Ova je animacija izrađena u digitalnoj tehnici s pomoću programa Blender, Clip Studio Paint 
i Sprite Illuminator. 
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2. HIBRIDNA ANIMACIJA 

Postoji mnogo vrsta animacije kao što su: klasična 2D animacija, računalna 3D animacija, 
stop-animacija itd. Sve vrste animacije mogu se upotrebljavati neovisno o drugima, tj. 
možemo imati potpunu 2D animaciju kao što je animirani film Song of the Sea (2014.) ili 
potpunu 3D animaciju poput animiranog filma How to Train Your Dragon (2010.). Međutim, 
svaka vrsta animacije ima svoje prednosti i mane. Vrlo je teško postići dinamičan pokret 
kamere s pomoću 2D animacijskih tehnika. Često nailazimo i na probleme perspektive i 
skraćivanja što stvara tehničke prepreke pri animaciji kretanja karaktera u prostoru i zahtijeva 
iznimnu vještinu animatora. S druge strane, ekstremno izobličavanje karaktera tehnički je 
zahtjevnije u potpunoj 3D animaciji nego u klasičnoj 2D animaciji.  

No, sve češće počinjemo viđati primjere hibridne animacije, tj. animacije koja nastaje kao 
spoj različitih vrsta animacije. Najčešće je riječ o spoju ručno crtane 2D animacije i 3D 
animacije. To ne bi bilo moguće bez velikih inovacija u području animacije i razvoja 
tehnologije. Tehnologija koja je prije bila dostupna samo nekolicini ljudi sada je pristupačnija 
i jeftinija što omogućuje lakše tehničke i medijske eksperimente u području animacije. 

Važno je napomenuti da postoji mnogo različitih načina kombiniranja 2D i 3D animacije, no 
ne nazivamo svaki takav spoj hibridnom animacijom. 

Na primjer, animirani film Wolfwalkers (2020.) u scenama koje prikazuju kako svijet izgleda 
iz vučje perspektive upotrebljava 3D pozadinu kao skicu za 2D animaciju (Snyder i Desiderio 
2021). Ovdje je riječ o primjeru upotrebe 3D animacije kao pomoć pri izradi 2D animacije, a 
ne o hibridnoj animaciji. 

 

Slika 1. Slika procesa animacije Wolfwalkers (2020.) 

Izvor: https://www.blender.org/user-stories/2d-isnt-dead-it-just-became-something-different-using-
blender-for-wolfwalkers/ (pristupljeno 29. 7. 2023.) 

https://www.blender.org/user-stories/2d-isnt-dead-it-just-became-something-different-using-blender-for-wolfwalkers/
https://www.blender.org/user-stories/2d-isnt-dead-it-just-became-something-different-using-blender-for-wolfwalkers/
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Povezano s hibridnom animacijom, jedna je od mogućnosti upotrebljavati 3D animaciju kao 
pozadinu, dok su likovi i objekti s kojima oni imaju izravnu interakciju 2D. Testna animacija 
Where The Wild Things Are (1983.) jedan je od najranijih primjera takve hibridne animacije. 
U današnje je vrijeme to čest postupak u izradi animiranih serijala i filmova. Primjer takvog 
spoja 2D i 3D animacije u animiranom filmu predstavlja Spirit: Stallion of the Cimarron 
(2002.) koji u potpunosti iskorištava prednosti 3D prostora i dinamične kamere kako bi 
postigao kadrove duljeg trajanja u kojima kamera „leti“ kroz 3D prostor i vrti se oko 2D 
karaktera. 

 

Slika 2. Prikaz kombinacije 2D i 3D animacije u filmu Spirit: Stallion of the Cimarron (2002.) 

Izvor: https://www.cgw.com/Publications/CGW/2002/Volume-25-Issue-5-May-2002-/Free-
Spirits.aspx (pristupljeno 2. 8. 2023.) 

S druge je strane i animirani film The Iron Giant (1999.) koji 2D animirane likove stavlja uz 
one koji su animirani u 3D-u kako bi naglasio razliku između likova i dao osvrt na tadašnje 
inovacije i pomake u svijetu animacije (Formenti 2021). 

 

Slika 3. Scena iz filma The Iron Giant (1999.) 

Izvor: http://what-when-how.com/hybrid-animation-integrating-2d-and-3d-assets/hybrid-animation-
the-main-problems-hybrid-animation-integrating-2d-and-3d-assets-part-1/ (pristupljeno 2. 8. 2023.) 

https://www.cgw.com/Publications/CGW/2002/Volume-25-Issue-5-May-2002-/Free-Spirits.aspx
https://www.cgw.com/Publications/CGW/2002/Volume-25-Issue-5-May-2002-/Free-Spirits.aspx
http://what-when-how.com/hybrid-animation-integrating-2d-and-3d-assets/hybrid-animation-the-main-problems-hybrid-animation-integrating-2d-and-3d-assets-part-1/
http://what-when-how.com/hybrid-animation-integrating-2d-and-3d-assets/hybrid-animation-the-main-problems-hybrid-animation-integrating-2d-and-3d-assets-part-1/
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Postoje i primjeri poput filma Treasure Planet (2002.) koji kombinira 2D animirane karaktere 
s 3D pozadinom i predmetima, ali i kombinira te dvije tehnike na liku Johna Silvera, čija je 
ruka 3D objekt (O'Hailey 2010: 94). 

 

Slika 4. Scena iz filma Treasure Planet (2002.) 

Izvor: https://m.imdb.com/title/tt0133240/mediaviewer/rm3953045504 (pristupljeno 2. 8. 2023.) 

Nalazimo i primjere gdje se 2D animacija upotrebljava kao dopuna 3D animaciji. Hōseki no 
Kuni (2017.) primjer je takve hibridne animacije. Jedna od mana 3D animacije jest 
nefleksibilnost na razini detalja. Poželjno je imati nižu razinu detalja na karakterima i 
predmetima koji se nalaze dalje od kamere jer u protivnom oni previše odvraćaju pažnju od 
onoga što je u prednjem planu. To je teže izvedivo kod 3D animacije jer 3D modeli ne 
mijenjaju svoju razinu detalja ovisno o tome gdje se nalaze u prostoru. To je bio jedan od 
problema u ovom animiranom serijalu. Karakteri koji u srednjem planu izgledaju dobro nisu 
dovoljno detaljni za krupne planove ili detalje i zbog toga ne uspijevaju prikazati željenu 
razinu emocije. Uz to, ponekad je teže dočarati premještanje mase i brzinu pokreta s pomoću 
3D animacije. U ovom se slučaju zbog toga 2D animacija crtala preko 3D animacije kako bi 
se postigla željena razina detalja, brzina pokreta ili bolje dočarala određena emocija (većinom 
u krupnim ili detalj-kadrovima) (kViN 2017). 

https://m.imdb.com/title/tt0133240/mediaviewer/rm3953045504
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Slika 5. Scena iz animirane serije Hōseki no Kuni (2017.) koja prikazuje 3D model lika s nacrtanim 
2D detaljima 

Izvor: https://steemit.com/anime/@grarkada/land-of-the-lustrous-a-review-glass-reflection 
(pristupljeno 9. 8. 2023.) 

Oblik hibridne animacije koji će biti prikazan u ovom radu kombinira 3D scenografiju s 2D 
karakternom animacijom na koju su dodani 3D materijali. Na taj se način 2D crtežu daje 
dojam trodimenzionalnosti i omogućava interakcija 2D animacije sa svjetlosnim efektima 
koji se nalaze u 3D prostoru. Tom je tehnikom moguće stvoriti odsjaje na metalu i u očima 
likova koji bi se u protivnom morali raditi ručno. Taj oblik hibridne animacije rijetka je 
pojava, no pronalazimo primjer u testnoj animaciji KnygT HunD Animation Pipeline Test 
(2020.). 

 

Slika 6. Prikaz iz videozapisa KnygT HunD Animation Pipeline Test (2020.) 

Izvor: https://www.youtube.com/watch?v=QRJet6Xlmxc (pristupljeno 2. 8. 2023.) 

https://steemit.com/anime/@grarkada/land-of-the-lustrous-a-review-glass-reflection
https://www.youtube.com/watch?v=QRJet6Xlmxc
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3. POSTUPAK IZRADE HIBRIDNE ANIMACIJE 

3.1. SINOPSIS 

Prva faza izrade hibridne animacije jednaka je prvoj fazi izrade bilo koje druge vrste 
animacije, a to je priprema za samu izradu animacije. 

Važno je jasno odrediti temu, osmisliti i odrediti što će biti prikazano, kako će biti prikazano i 
kojim redoslijedom kako bi se izbjegli (ili umanjili) problemi u daljnjoj produkciji. Upravo 
zbog toga započinjemo sinopsisom. Sinopsis je sažeti opis onoga što će biti prikazano u djelu, 
odnosno radnje filma, te čini dio početne faze ili pretprodukcije izrade animiranog djela. 

Sinopsis ne bi trebao sadržavati opise unutarnjeg stanja likova, dijalog, misli ni detaljne opise 
likova i prostora. Prilikom pisanja sinopsisa važno je usredotočiti se na jasno definiranje 
onoga što će biti prikazano. 

Za primjer dajem sinopsis koji čini praktični dio ovoga rada: 

Miš popravlja brod za drugog miša u radionici. Odmahuje mu dok on popravljenim brodom 
plovi dalje od radionice. Dolazi kornjača s pokvarenim motorom koji joj miš popravlja te 
potom i ona odlazi. Dolazi gušter s pokvarenim avionom, a miš i njemu pomaže popraviti ga. 
Gušter zatim odleti s popravljenim avionom. 

Miš na kraju dana umorno posprema radionicu, ali tada se nad njim pojavljuje velika sjena. 
On se okreće i ugleda ispred sebe veliku sovu. Uplašen, skriva se iza svojega radnog stola i 
viri preko ruba. Sova se pomiče i otkriva još jednu malu sovu iza sebe. Mala sova nesigurno 
napravi nekoliko koraka naprijed, raširi svoja krila i zamahuje njima pokazujući da je jedno 
puno manje od drugoga. Miš je tužno gleda. 

Sljedeći dan miš pokušava popraviti krilo. Izrađuje kartonsko krilo i veže ga za malu sovu. 
Mala sova pokušava poletjeti s pomoću novog krila, kratko se zadržava u zraku, ali ne 
uspijeva poletjeti te licem pada na pod. Velika sova i miš trznu se kad udari o pod. 

Miš izrađuje raketu i veže je za malu sovu. Mala sova s raketom odleti u visinu, čuje se udar i 
dijelovi krova padnu dolje pokraj miša i velike sove. 

Miš za malu sovu (koja na glavi ima zavoj) veže balon. Mala sova radosno maše krilima i 
lebdi prema gore. Izgleda zabrinuto kada se uzdigne previše visoko i trza se kako bi se 
spustila dolje. Balon zapinje za oštar dio razbijenog krova i puca. Mala sova pada licem na 
pod. 

Miš veže propeler za sovu te ona lebdi u zraku okrećući se oko svoje osi.  

Mala sova ostavlja propeler na stolu i izlazi iz radionice. Gleda u nebo s tužnim izrazom lica. 
Dolazi velika sova i nudi joj da je nosi na leđima dok leti. Mala sova odmahuje glavom, maše 
krilima i gestikulira u nebo pokazujući da sama želi letjeti. Miš promatra tu scenu, vraća se 
za radni stol i provodi cijelu noć tražeći rješenje. 
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Sljedeći dan mu velika sova pomaže da naprave novo krilo i te večeri pozovu malu sovu da 
ga isproba. Mala sova skeptično promatra novo krilo, ali na nagovor velike sove i miša 
pokušava ponovno poletjeti. Mala sova uspijeva poletjeti i izlijeće iz radionice. Velika sova 
pridružuje joj se u letu. Miš ih promatra. One se vrate te ponesu i njega u zrak. 

 3.2 MODEL-LISTA 

Sljedeći je korak izrada model-liste. Model-lista sadržava detaljan prikaz svih vizualnih 
elemenata filma. Model-lista sastoji se od likovnih rješenja karaktera, koja jasno prikazuju 
kako karakteri u filmu trebaju izgledati, i likovnih rješenja pozadina, koja prikazuju kako će 
pozadine izgledati u filmu (Marušić i suradnici 2004: 159). Za ovaj se rad model-lista sastoji 
od triju likovnih rješenja karaktera i jednoga likovnog rješenja pozadine. 

 

 Slika 7. Likovno rješenje karaktera miša 
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Slika 8. Likovno rješenje karaktera male sove 

 

Slika 9. Likovno rješenje karaktera velike sove 
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Slika 10. Likovno rješenje pozadine 

3.3. KNJIGA SNIMANJA 

Sljedeća je faza izrade animacije knjiga snimanja (engl. storyboard). Knjiga snimanja 
sadržava redne brojeve scena, brojeve kadrova, trajanje kadrova, kratki opis onoga što je 
prikazano u kadru te skicu kadra. 

Po potrebi se za jedan kadar može raditi nekoliko skica kako bi se pojasnila radnja prikazana 
u tim kadrovima. U opisu kadra i na skici trebao bi biti naznačen i pokret kamere te pokret 
karaktera u kadru. U ovom radu je pokret kamere naznačen crvenom bojom, dok je pokret 
karaktera prikazan zelenim strelicama. 

 

Slika 11. Stranica iz knjige snimanja  
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3.4. IZRADA 3D SCENOGRAFIJE 

Jedna od brojnih odluka koje sam morala donijeti prilikom izrade ove animacije jest kako 
prikazati prostor u kojem se radnja odvija. Kao što sam već navela, jedna je od mana 2D 
animacije teškoća upotrebe dinamičnog pokreta kamere u prostoru. Mnogi računalni 
programi za animaciju danas nam daju mogućnost slaganja 2D crteža u 3D scenu. Takav 
način rada omogućava nam slobodniji pokret kamere, ali još uvijek nailazimo na ograničenja. 
Prevelik pokret kamere mogao bi uništiti iluziju trodimenzionalnosti ili dovesti do čudnih 
skraćivanja u prostoru koji bi mogli zbuniti gledatelja, za razliku od 3D scenografije u kojoj 
možemo slobodno pomicati virtualnu 3D kameru bez takvih poteškoća. 

To ne znači da je upotreba 3D scenografije uvijek bolja opcija. Na primjer, u slučajevima 
kada se radnja odvija u vrlo detaljnom prostoru koji je vidljiv na samo nekoliko sekundi i 
kamera je statična, izrada 3D scenografije zahtijevala bi previše vremena, a ne bismo 
iskoristili prednosti koje nam ona daje. S druge strane, ako se isti prostor često pojavljuje i 
potrebno ga je prikazati iz različitih pogleda ili planiramo upotrijebiti dinamičnu kameru, 
tada bi nam izrada 3D scenografije pomogla ostvariti željene rezultate i u nekim slučajevima 
uštedjeti vrijeme. 

Iz sinopsisa možemo iščitati da se cijela radnja odvija u miševoj radionici, a u knjizi snimanja 
možemo vidjeti da će biti potrebno prikazati taj prostor iz raznih pogleda, uključujući i velik 
pokret kamere u nekim kadrovima. Zbog toga sam odlučila scenografiju izraditi u 3D-u. 

Izrada 3D scenografije u ovom primjeru hibridne animacije odrađena je s pomoću programa 
Blender. Blender je računalni program za 3D grafiku, koji se upotrebljava u svrhu izrade 3D 
modela, vizualnih efekata, animacije i dr. 

3D modeliranje postupak je izrade virtualnih trodimenzionalnih modela, a rezultat 3D 
modeliranja jest virtualni 3D model. 3D modeliranje može biti destruktivno i nedestruktivno. 
Destruktivno 3D modeliranje podrazumijeva proces uređivanja oblika 3D modela koji 
izravno stvara trajne promjene na mreži 3D modela. Nedestruktivno modeliranje proces je 
mijenjanja oblika 3D modela koji ne stvara trajne promjene i može se prilagođavati ili u 
potpunosti ukloniti u bilo kojem trenutku. Primjer je upotreba modifikatora (engl. Modifier) u 
Blenderu, tj. automatskih operacija koje na nedestruktivan način mijenjaju geometriju objekta 
(Blender Documentation Team 2023). 

Za izradu šest kadrova koji čine praktični dio ovoga rada bilo je potrebno izraditi radionicu u 
kojoj se radnja odvija. Taj je proces uključivao izradu arhitektonskih elemenata radionice, 
namještaja, sitnih predmeta, bilja, vode i neba. Za izradu većine predmeta odlučila sam 
upotrijebiti metodu poligonalnog modeliranja u kojoj su 3D modeli predstavljeni s pomoću 
vrhova (engl. Vertex), bridova (engl. Edge) i poligona (engl. Face) u 3D prostoru. Tu sam 
odluku donijela jer je bilo poželjno da što više predmeta ima urednu i jednostavnu mrežu 
(engl. Mesh) zbog tehničkih ograničenja računala kojim sam se služila, a metoda 
poligonalnog modeliranja omogućuje ostvarivanje takvih rezultata na brz i jednostavan način. 
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Taj proces započinje dodavanjem primitivnog mrežastog objekta koji svojim oblikom najviše 
odgovara objektu koji želim napraviti. Te primitivne objekte možemo pronaći u zaglavlju 
(engl. Header) u padajućem izborniku Add. Primjerice, za izradu kutije u izborniku Add 
odabrala sam opciju Mesh ‣ Cube kojom je u 3D scenu na mjesto određeno 3D kursorom 
dodan jednostavan model 3D kocke (slika 12). 

 

Slika 12. Padajući izbornik Add 

Da bismo mogli uređivati taj 3D model upotrebom metode poligonalnog modeliranja, 
moramo se prebaciti iz objektnog načina rada (engl. Object Mode) u uređivački (engl. Edit 
Mode) (slika 13). Uređivački način rada služi za uređivanje elemenata objekta, ovisno o 
njihovoj vrsti. Kod mrežastih objekata omogućava uređivanje mreže objekta, tj. daje 
mogućnost mijenjanja veličine, položaja i rotacije vrhova, bridova i poligona koji čine mrežu 
virtualnog 3D objekta. Možemo i dodavati i uklanjati vrhove, bridove i poligone koji čine tu 
mrežu (slika 14). 

 

Slika 13. Prebacivanje u uređivački način rada 
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Slika 14. Uređivanje mreže 3D objekta 

Pri izradi kutije upotrebljavala sam i modifikatore kako bih postigla željeni izgled predmeta. 
Jedan od tih modifikatora bio je Bevel koji omogućava dodavanje geometrije na rubovima 3D 
modela što im daje mekši izgled (slika 15). Na nekim modelima upotrebljavala sam i 
Subdivision Surface modifikator koji poligone koji čine mrežu 3D objekta dijeli na manje 
poligone. S pomoću ovog modifikatora možemo dobiti glađi izgled površine bez destruktivne 
izmjene mreže objekta. Upotrebljavala sam i Displace modifikator koji s pomoću teksture (u 
ovom slučaju Voronoi teksture) može dodatno iskriviti površinu objekta. 
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Slika 15. Bevel, Subdivision Surface i Displace modifikatori 

Neki su objekti izrađeni i s pomoću fizičke simulacije. Iako je simulacija metoda 3D 
animacije, može nam poslužiti i pri izradi 3D objekta kao što su jastuk i zastori vidljivi na 
slici 16. Jastuk i zastori napravljeni su s pomoću fizičke simulacije tkanine (Physics 
Properties ‣ Cloth) i zatim dodatno uređeni tehnikama poligonalnog modeliranja i 3D 
kiparenja. Za izradu jastuka potrebno je dodati Plane objekt i podijeliti njegovu mrežu na 
manje poligone tako da u uređivačkom načinu rada desnim klikom miša pozovemo izbornik i 
odaberemo opciju Subdivide. Razina detalja ovisit će o količini poligona. Zatim ćemo 
označiti cijelu mrežu i s pomoću alata Extrude Region izvući poligone prema gore (slika 16). 

 

Slika 16. Prikaz mreže objekta nakon izvlačenja označene geometrije 



14 
 

Potom ćemo u postavkama fizičke simulacije (engl. Physics Properties) odabrati opciju za 
simulaciju tkanine (engl. Cloth). U izborniku Field Weights isključit ćemo gravitaciju jer nam 
u ovom slučaju nije potrebna. Omogućit ćemo opciju za pritisak (engl. Pressure) i povećati 
pritisak dok ne dobijemo zadovoljavajuće rezultate. Detalje možemo dodati s pomoću 
Subdivision Surface modifikatora ili možemo trajno primijeniti efekte simulacije na objekt (u 
postavkama modifikatora označimo Cloth i na tipkovnici pritisnemo kombinaciju tipki Ctrl + 
A) te dodati detalje tehnikama poligonalnog modeliranja i 3D kiparenja. 

 

Slika 17. Jastuk napravljen fizičkom simulacijom i dodatno uređen tehnikama poligonalnog 
modeliranja i 3D kiparenja 

Tijekom izrade 3D scenografije važno je obratiti pažnju na kompleksnost scene jer velik broj 
kompleksnih 3D objekata može preopteretiti računalo. Objekti koji imaju velik broj poligona 
i upotrebljavaju kompleksne modifikatore i simulacije zahtjevniji su za kalkulacije prilikom 
izrade prikaza (engl. Rendering) od jednostavnih objekata s malim brojem poligona. Neke 
sam objekte ubacila kao 2D plohe da bih smanjila opterećenje računala, npr. stabla i grmlje. 
Zbog toga sam ih izradila u posebnom projektu. Zatim sam izradila prikaz tih objekata i 
ubacila ih kao 2D plohe u 3D scenu. Bolji pristup bio bi ostaviti 3D objekte u sceni jer ćemo 
na taj način dobiti korektniju simulaciju svjetla i sjene. No, ovo je jedno od mogućih rješenja 
u slučajevima gdje smo ograničeni tehničkim specifikacijama računala (slika 18). 
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Slika 18. Drveće na 2D plohi 

Nakon što sam završila s 3D modeliranjem predmeta koji su potrebni u sceni, započela sam 
izradu teksturiranih materijala. 

Za dodavanje tekstura, tj. slika koje se projiciraju na površinu 3D objekta, na naše objekte 
potrebno je u postavkama materijala programirati sjenčare (engl. Shader). Sjenčare 
programiramo tako da povezujemo različite čvorove (engl. Node) i mijenjamo njihove 
postavke. S pomoću čvorova možemo napraviti proceduralno generirane teksture ili ubaciti 
ručno slikane teksture u materijal objekta (primjer proceduralno generirane teksture tkanine 
možemo vidjeti na slici 19). Upotrebljavamo li ručno slikane teksture, potrebno je napraviti 
UV razmatanje 3D mreže objekta (engl. UV Unwrapping).  

 

Slika 19. Proceduralno generirane teksture za tkaninu 

Moguće je upotrebljavati i kombinaciju ovih dviju metoda.  

Za teksturiranje predmeta u ovom sam primjeru upotrijebila nekoliko proceduralnih tekstura i 
sedam ručno slikanih tekstura. Na slici 20 nalaze se primjeri tih ručno teksturiranih predmeta. 
Na slici 21 možemo vidjeti UV mrežu tih predmeta, a na slici 22 njihovu ručno slikanu 
teksturu. 
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Slika 20. Ručno teksturirani objekti 

 

Slika 21. UV mreža objekata 
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Slika 22. Ručno slikane teksture 

Za određene predmete bilo je jednostavnije napraviti proceduralne teksture. Npr. oblaci i 
nebo proceduralno su generirani prema praktičnom vodiču Kristofa Dedenea 
(https://www.youtube.com/watch?v=m4aOZm6auxQ). Određene dijelove proceduralnih 
materijala možemo i animirati. Na primjer, kako bih animirala blago svjetlucanje zvijezda na 
nebu, u Voronoi Texture čvoru animirala sam W koordinatu s pomoću kratkoga programskog 
izraza #frame/80000 (slika 23). 

 

Slika 23. Animirana Voronoi tekstura 
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Kako bi se 2D animacija bolje uklopila u 3D scenografiju, na 3D rekvizite dodan je linijski 
crtež s pomoću Grease Pencil objekta i Line Art modifikatora. Grease Pencil objekt je u 
Blenderu koji omogućuje crtanje linija u 3D prostoru. Line Art modifikator daje nam 
nekoliko opcija generiranja takvog crteža ovisno o položaju kamere, lokaciji i geometriji 
predmeta u sceni. Postavke Line Art modifikatora koje su upotrijebljene za generiranje 
linijskog crteža u ovoj sceni možemo vidjeti na slici 24. 

 

Slika 24. Postavke Line Art modifikatora 

Zatim slijedi postavljanje svjetla u scenu. Blender nudi nekoliko vrsta svjetlosnih objekata, a 
to su točkasto svjetlo, usmjereno svjetlo, difuzno svjetlo i sunce (engl. Point, Spot, Area i 
Sun). Svi izvori svjetla u prostoru koji sam izradila sadržavaju svoj svjetlosni objekt u 
jednom od navedenih oblika, ovisno o obliku i vrsti izvora svjetla (slika 25). Scena sadržava i 
jedan svjetlosni objekt u obliku sunca koje obasjava čitavu scenu. Dodatni svjetlosni objekti 
ubačeni su u pojedine kadrove po potrebi i nalaze se u posebnoj kolekciji (engl. Collection) 
za taj kadar kako bi ih se moglo lako isključiti pri izradi prikaza drugih kadrova. 
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Slika 25. Svjetla u radionici 

3.5. 3D SKICA ZA ANIMACIJU 

Kako bih osigurala da se pokret karaktera u prostoru slaže s pokretom 3D kamere, izradila 
sam jednostavne 3D modele karaktera koji će služiti kao prva skica za 2D animaciju. Ti 
modeli ne sadržavaju sve detalje karaktera jer im je glavna svrha prikazati osnovni oblik 
karaktera, lokaciju i pokret u prostoru. Potreban nam je kostur za omogućavanje animacije tih 
modela (engl. Skeleton) koji pridružujemo 3D modelu u hijerarhijskom odnosu roditelj – 
dijete. To možemo učiniti tako da označimo objekt i kostur, pozovemo izbornik desnim 
klikom miša i odaberemo opciju Parent ‣ With Automatic Weights. U ovom primjeru kostur 
sam napravila s pomoću Rigify dodatka (engl. Add-on) koji je dostupan u Blenderu (slika 26). 

Kosti pokreću dijelove 3D modela ovisno o podatcima o težini (engl. Weight) koji su sadržani 
u 3D modelu s pomoću pripadnosti vrhova grupi vrhova (engl. Vertex Group). Blender daje 
mogućnost automatskog raspoređivanja težine, no važno je provjeriti jesu li te težine ispravno 
generirane. U ovom slučaju morala sam napraviti nekoliko korekcija da bi se modeli pravilno 
pokretali. 
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Slika 26. 3D model i kostur velike sove napravljen s pomoću Rigify dodatka 

Sljedeći je korak bio animiranje modela. U Blenderu se 3D modeli animiraju s pomoću 
ključnih poza (engl. Keyframe) koje dodajemo na vremenskoj traci (engl. Timeline). Modele 
poziramo tako da pomičemo pojedine kosti na kosturu, zatim upisujemo ključnu pozu tako da 
desnim klikom miša na vremensku traku pozovemo izbornik i odaberemo opciju Insert 
Keyframes (slika 27). Možemo upisati ključne poze za sve transformacije koje smo napravili 
na kostima ili možemo napraviti ključnu pozu samo za rotaciju, veličinu ili lokaciju pojedine 
kosti. Blender će zatim napraviti faze između svake ključne poze ovisno o izabranoj 
interpolaciji animacije. Za interpolaciju imamo nekoliko opcija koje su vidljive na slici 28. 
Možemo dodatno kontrolirati interpolaciju animacije s pomoću krivulja koje su dostupne u 
uređivaču grafova Graph Editor. 

 

Slika 27. Upisivanje ključne poze 
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Slika 28. Opcije za interpolaciju 

Svaka krivulja u Graph Editor sučelju predstavlja određenu transformaciju (lokacije, rotacije 
i veličine) spremljenu na vremenskoj traci. Na primjeru slike 29 možemo vidjeti da plava 
linija predstavlja modifikacije po Z osi, crvena po X osi, a zelena po Y osi. 

 

Slika 29. Prikaz krivulja u Graph Editor sučelju 

Kako ne bih morala odvajati svaki kadar u posebnu scenu, odlučila sam upotrijebiti posebne 
akcije (engl. Action) koje su u Blenderu dostupne u kartonu snimanja (engl. Dope Sheet) pod 
opcijom Action Editor. Akcije su blokovi podataka (engl. Data blocks) koji sadržavaju 
informacije o animaciji u obliku ključnih poza i grafova pokreta na vremenskoj traci, tj. 
akcije su spremljeni animacijski podatci. Akcije dodajemo tako da odaberemo opciju New u 
sredini sučelja Action Editor prozora (slika 30). 
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Slika 30. Dodavanje nove akcije 

Nakon što su 3D skice za 2D animaciju dovršene, potrebno ih je izraditi kao niz 2D slika 
kako bismo ih mogli ubaciti u program za izradu 2D animacije. To možemo napraviti tako da 
u izlaznim postavkama (engl. Output Properties) odaberemo jedan od formata slika (u ovom 
slučaju odabrala sam opciju PNG). S obzirom na to da ćemo ovaj niz slika upotrijebiti samo 
za skicu, nije potrebno uključivati sve teksture i materijale u izradu prikaza. Zbog toga sam 
pogon za izradu prikaza prebacila na Workbench koji je brži od pogona Cycles i Eevee, a daje 
željene rezultate. Zatim u gornjoj traci (engl. Topbar) odaberemo opciju Render ‣ Render 
Animation (slika 31). Niz slika bit će spremljen na mjesto određeno u izlaznim postavkama. 

 

Slika 31. Izrada niza slika 

3.6. 2D ANIMACIJA 

Izradu 2D animacije odlučila sam odraditi u programu Clip Studio Paint. Clip Studio Paint je 
računalni program za crtanje i slikanje koji ima opcije za izradu 2D animacije.  

Da bismo započeli s izradom animacije, potrebno je u programu pozvati sučelje za animaciju. 
To možemo napraviti tako da u donjem lijevom kutu pritisnemo dvije strelice prema gore 
(slika 32). Prije nego što počnemo animirati, moramo napraviti novu vremensku traku 
pritiskom na opciju New timeline (slika 33) nakon čega će nam se na zaslonu pojaviti novi 
prozor u kojem možemo mijenjati postavke vremenske trake. Zatim moramo izraditi novu 
mapu za animaciju odabirom opcije New animation folder (slika 34). 
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Slika 32. Lokacija sučelja za animaciju 

 

Slika 33. Lokacija opcije New timeline 

 

Slika 34. Lokacija opcije New animation folder  

Nakon izrade nove mape za animaciju, možemo ubaciti niz slika koji smo izradili u Blenderu 
tako da u gornjoj traci odaberemo File ‣ Batch process opciju. Batch process opcija daje nam 
mogućnost da postavljamo naredbe izbornika koje će se izvršavati na više stranica ili platna 
odjednom. Otvorit će nam se novi prozor u kojem trebamo u Run okviru odabrati izbornik 
Menu commands i zatim odabrati opciju File ‣ Import ‣ Image (to znači da ćemo upotrijebiti 
naredbu iz izbornika za ubacivanje slika). U okviru Apply to odaberemo Current canvas 
opciju (što znači da će slike biti ubačene na trenutačno platno) i u Save options okviru 
odaberemo opcije Close without saving i Do not close open canvases. Pritiskom na OK 
pozvat ćemo prozor u kojem trebamo izabrati slike koje želimo ubaciti. Kada smo odabrali 
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slike koje želimo, pritisnemo opciju Open. Nakon toga će svaka slika u našem nizu biti 
ubačena na platno na zasebnom sloju (engl. Layer). U Layer okviru zatim trebamo označiti 
sve slojeve koji sadržavaju naš niz i povući ih u mapu za animaciju koju smo izradili.  

Primijetimo da se slike, iako se nalaze u mapi za animaciju, ne pojavljuju na vremenskoj traci 
(slika 35). Da bismo ih tamo dodali, potrebno je u izborniku Animation (slika 36) odabrati 
opciju Edit track ‣ Batch specify cels. Otvorit će nam se novi prozor u kojem je potrebno 
odabrati opciju Specify name of existing animation cel kojom će se slike na vremenskoj crti 
poredati prema svojem nazivu. Ostale postavke trebaju izgledati kako je prikazano na slici 
37.  

 

Slika 35. Slike se nalaze u mapi za animaciju, ali se ne pojavljuju na vremenskoj traci 

 

Slika 36. Animation ‣ Edit track ‣ Batch specify cels 
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Slika 37. Batch specify cels prozor 

Za 2D animaciju napravit ćemo novu mapu za animaciju i novi sloj u toj mapi. Clip Studio 
Paint nudi dvije vrste slojeva, prvi je rasterski sloj (engl. Raster layer) za stvaranje rasterskog 
crteža, a drugi je vektorski sloj (engl. Vector layer) koji prikazuje linije kao vektorske 
krivulje koje možemo nakon crtanja pomicati, mijenjati im debljinu, boju i oblik. Za izradu 
ove animacije odabrala sam rasterski sloj za 2D skicu i vektorski sloj za čiste linije. 

Nakon izrade linija, stvaramo novu mapu za animaciju u kojoj ćemo raditi ispunu bojom. 
Clip Studio Paint daje mogućnost upotrebe grupa kao sličica animacije (engl. Animation cel). 
To znači da pri izradi ispune možemo imati grupu u kojoj se nalazi više slojeva, svaki koji 
sadržava ispunu za određeni dio crteža, i upotrebljavati tu grupu kao sličicu animacije. Tako 
će nam se sva ispuna bojom nalaziti u jednoj mapi za animaciju, a moći ćemo zasebno 
uređivati svaki dio ispune bez utjecanja na druge dijelove ispune. 

Nakon što smo izradili linije i obojili crtež, potrebno je izvesti (engl. Export) animaciju kao 
niz slika i napraviti nizove slika za 3D materijale. Prvi niz slika sadržavat će linije i boje te će 
služiti kao baza na koju ćemo dodavati 3D efekte. 

Drugi niz slika bit će teksture koje sadržavaju podatke za određivanje izgleda materijala. Te 
teksture sastojat će se od crvene, plave i zelene boje. Svaka boja određivat će koji će dio slike 
upotrebljavati drugačije postavke materijala. Drugim riječima, spremit ćemo podatke za 
određivanje materijala u RGB kanale slike. Npr. želimo li da oči na liku sove izgledaju kao 
glatki odnosno sjajni materijal, obojit ćemo ih zelenom bojom. Svi drugi dijelovi crteža koji 
su obojeni zelenom bojom primjenjivat će iste postavke materijala. 
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Sljedeći niz sadržavat će linije s bijelom ispunom. Taj niz slika upotrebljavat ćemo kasnije za 
izradu mape normala koja će našem 2D crtežu dati iluziju trodimenzionalnosti.  

Zadnji niz slika sadržavat će bijele odsjaje u očima.  

 

Slika 38. Prikaz procesa animacije: skica, linije, ispuna bojom, tekstura za određivanje materijala, 
odsjaji u očima 

Tehnika koja je opisana u ovom dijelu kombinacija je 3D animacije i rotoskopije. 
Rotoskopija je tehnika u kojoj animatori precrtavaju pokret glumca ili drugog subjekta sa 
niza filmskih sličica koje čine prethodno snimljeni film. Ta tehnika omogućuje stvaranje 
prirodnije iluzije pokreta. U ovom sam slučaju umjesto snimke filma upotrijebila 3D 
animaciju karaktera kako bih lakše zadržala njihove proporcije i pratila njihov pokret u 
odnosu na kameru. 

3.7. POSTAVKE 3D MATERIJALA NA 2D ANIMACIJI 

2D animaciju koju smo izveli iz Clip Studio Painta zatim ubacujemo kao niz slika natrag u 
Blender. Kako bismo omogućili tu opciju, moramo uključiti dodatak Import-Export: Import 
Images as Planes tako da u izborniku Edit ‣ Preferences odaberemo opciju Add-ons i 
pritisnemo prazan kvadratić ispred dodatka Import-Export: Import Images as Planes. 

Sada možemo odlaskom u izbornik File ‣ Import ‣ Images as Planes odabrati niz slika koju 
želimo ubaciti u Blender. Prilikom odabira slika potrebno je označiti opciju Animate Image 
Sequences u desnom dijelu prozora kako bi se niz slika ubacio kao jedna animirana ploha. 

Blender će taj niz slika prikazati kao plohu koja se može slobodno pomicati i iskrivljivati u 
3D prostoru. Tu plohu pridružila sam kameri kao hijerarhijsko „dijete“ kako bi ona slijedila 
pokret kamere (slika 39). 
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Slika 39. Pridruživanje plohe s 2D animacijom kameri kao hijerarhijsko „dijete“ 

Zatim slijedi izrada materijala za 2D animaciju. U uređivaču sjenčara (engl. Shader Editor) 
možemo vidjeti da već imamo dva povezana čvora; Image Texture čvor i Principled BSDF 
čvor. Prvo ćemo ubaciti niz slika koji sadržava teksture za materijale tako da u izborniku Add 
odaberemo Texture ‣ Image Texture. Pojavit će se novi čvor u kojem trebamo odabrati opciju 
Open i odabrati niz slika koji sadržava teksture za određivanje materijala.  

Naša tekstura za određivanje materijala trenutačno sadržava više podataka spremljenih u 
RGB kanale teksture. Kako bismo te podatke upotrebljavali u programiranju našeg sjenčara, 
potrebno ih je razdvojiti u zasebne crno-bijele podatke. To možemo napraviti tako da dodamo 
Separate Color čvor i spojimo Color izlaz Image Texture čvora s Color ulazom Separate 
Color čvora.  

Nakon toga spojit ćemo Red, Green i Blue izlaze s posebnim Color Ramp čvorovima koji 
remapiraju ulazne vrijednosti s pomoću tonske skale boja. Svaki Color Ramp zatim ćemo 
spojiti s ulazom u Principled BSDF čvor ovisno o tome koju postavku želimo primijeniti na 
pojedine dijelove slike. 

Npr. Color Ramp u koji je spojena zelena boja spojit ćemo s Roughness ulazom. S pomoću 
Color Ramp čvora možemo odrediti koliko će površine koje su određene zelenom bojom i 
one koje su izvan nje izgledati glatko ili grubo. Na slici 40 možemo primijetiti da su površine 
koje su određene zelenom bojom sjajne i glatke, dok površine koje su izvan zelene boje 
nemaju sjaj. 
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Slika 40. Upotreba Green kanala slike za postizanje efekta sjajne površine na 2D animaciji 

Nakon toga želimo simulirati reljefnost na plohi s 2D animacijom. U Blenderu to možemo 
postići upotrebom mape normala.  

Mape normala teksture su koje služe za stvaranje iluzije trodimenzionalne reljefnosti na 
površini, tako da se trokomponentna boja (R, G, B) svakog piksela čita kao trokomponentni 
(X, Y, Z) vektor normale zakošenosti plohe. Njihova je svrha dati dodatnu razinu detalja bez 
povećanja broja poligona na mreži 3D objekta.  

Postoji mnogo načina izrade mape normala. Pri izradi animacije nije preporučljivo ručno 
slikati mape normala zbog vremena koje je potrebno uložiti u izradu pojedine slike (iako bi 
nam ova opcija dala bolju kontrolu nad izgledom mape normala). Vremenski je bolji izbor 
generirati mape normala od 2D crteža, no važno je napomenuti da u tom slučaju imamo 
manje kontrole nego kod ručne izrade jer smo ograničeni opcijama i alatima koje nam 
pružaju pojedini programi za generiranje mapa normala. Za ovaj rad odlučila sam generirati 
mape normala s pomoću programa Sprite Illuminator. 

Nakon što pokrenemo Sprite Illuminator, dodajemo niz slika tako da ga označimo u mapi u 
kojoj se nalazi i povučemo u prostor za sprajtove (možemo ih dodati i opcijom Edit ‣ Add 
Sprites u gornjoj traci). 

S pomoću izbornika na desnoj strani možemo mijenjati postavke mape normala. U donjem 
lijevom kutu možemo mijenjati prikaz u prozoru i pregledati kako će mapa normala izgledati 
(slika 41). U samom 3D prozoru nalazimo jedno svjetlo koje možemo pomicati preko slike i 
vidjeti kako će ono utjecati na plohu pod utjecajem novonastale mape normala. Preporučljivo 
je označiti sve slike u prostoru za sprajtove kako bi se sve postavke koje mijenjamo 
automatski primjenjivale na sve slike. Kad smo zadovoljni s izgledom mape normala, 
potrebno ju je izvesti (engl. Export) odabirom File ‣ Export ‣ Export Normals (slika 42). 
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Slika 41. Program Sprite Illuminator  

 

Slika 42. File ‣ Export ‣ Export Normals 

Da bismo primijenili mapu normala na našu 2D animaciju, moramo dodati novi Image 
Texture čvor i u njega učitati niz mapa normala koji smo upravo izradili. Potreban nam je i 
Normal Map čvor u čiji Color ulaz ćemo spojiti Color izlaz našeg niza slika. Normal Map 
čvor spajamo u Normal ulaz u Principled BSDF čvoru (slika 43). 
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Slika 43. Ubacivanje mape normala u materijal plohe s 2D animacijom 

S pomoću mape normala možemo dodati i rubno svjetlo (engl. Rim light) tako da mapu 
normala spojimo u Normal čvor (koji upotrebljavamo za promjenu smjera rubnog svjetla). 
Dot izlaz Normal čvora zatim spajamo u Blend ulaz na Layer Weight čvoru, zatim Fresnel 
izlaz spajamo u Color Ramp čvor kojim prilagođavamo oštrinu i snagu rubnog svjetla (slika 
44). 

 

Slika 44. Postavljanje rubnog svjetla 

Nakon toga dodajemo još jedan Color Ramp čvor kojim ćemo određivati boju svjetla. Color 
izlaz prvog Color Ramp čvora spajamo s Fac ulazom drugoga. Color izlaz drugog Color 
Ramp čvora spajamo s Color ulazom Emission sjenčarskog čvora (engl. Shader Node). 
Emission sjenčarski čvor omogućuje objektima i materijalima emitiranje svjetlosti, u ovom 
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primjeru upotrebljavamo skup čvorova koji će omogućiti da dijelovi 2D slike svijetle ovisno 
o izgledu mape normala i položaju Normal čvora. 

Naposljetku dodajemo Add Shader čvor u kojem zbrajamo Principled BSDF i Emission 
sjenčarske čvorove (slika 45). 

 

Slika 45. Spajanje Principled BSDF i Emission sjenčarskih čvorova 

Želimo li imati različite vrste i boje rubnog svjetla, možemo ponoviti ovaj postupak i svaki 
Emission sjenčarski čvor povezati s Add Shader čvorom. U ovom sam primjeru napravila 
jednu grupu koja sadržava svjetlo s nježnim prijelazom svjetla i jednu grupu s oštrim 
prijelazom svjetla (slika 46). 

 

Slika 46. Kombinacija dviju vrsta rubnog svjetla 

Odsjaji u očima likova u ovom su primjeru u posebnom nizu slika, što mi omogućuje 
mijenjanje prozirnosti i jačine odsjaja. Kad bi ti odsjaji bili u istom nizu kao i baza animacije 
bilo bi potrebno ponovno izrađivati niz slika animacije svaki put kada želimo napraviti takvu 
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promjenu. Na isti način možemo odvojiti i druge dijelove animacije te ih zasebno uređivati s 
pomoću čvorova ako nam je to potrebno. 

Kako bismo niz slika koji sadržava te odsjaje dodali na 2D animaciju moramo dodati novi 
Image Texture čvor. Color izlaz tog čvora spojit ćemo s Color Ramp čvorom kako bismo 
kontrolirali prozirnost odsjaja, a njegov Color izlaz spojit ćemo s Color ulazom Emission 
Shader čvora koji zatim spajamo s pomoću novog Add Shader čvora u prijašnji Add Shader 
čvor (slika 47). 

 

Slika 47. Dodavanje odsjaja u očima 

Zadnji je korak dodavanje Transparent BSDF sjenčarskog čvora koji nam služi da sve efekte 
koje smo stvorili u materijalu ograničimo na sam crtež, tj. Transparent BSDF osigurat će nam 
da se svi efekti koje dodajemo na 2D animaciju pojavljuju samo na crtežu, a ne izvan njega. 
Za postavljanje prozirnosti potreban nam je Image Texture čvor koji sadržava cijelu 
animaciju (linije i boje, može se upotrebljavati i maska koja obuhvaća cijelu površinu 2D 
animacije) čiji je Alpha izlaz spojen u Color Ramp čvor. Ovoga puta upotrijebit ćemo Mix 
Shader sjenčarski čvor. Color izlaz Color Ramp čvora spojit ćemo u Fac ulaz u Mix Shader 
čvoru. Prijašnji Add Shader priključit ćemo u prvi Shader ulaz novog Mix Shader čvora, a 
Transparent BSDF priključit ćemo u drugi (slika 48). 
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Slika 48. Dodavanje Transparent BSDF sjenčarskog čvora 

 

Slika 49. Završen materijal plohe s 2D animacijom 

3.8. SLOJEVI PRIKAZA 

Tijekom izrade animacije naišla sam na jedno ograničenje Blenderova Grease Pencil objekta. 
Prilikom generiranja Grease Pencil linija primijetila sam da Blender pri crtanju linija tretira 
plohu s 2D animacijom kao potpuno neproziran objekt, bez obzira na to što ona sadržava 
prozirne dijelove. To se događa zato što se linije Line Art modifikatora stvaraju po 3D 
geometriji (rubovima ploha), a ne po rubu alfe slike. 

Želimo li da se linije pojavljuju iza 2D animacije, moramo isključiti plohu s 2D animacijom i 
zatim generirati linije u Line Art modifikatoru. No, nailazimo na još jedan problem: Blender 
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uvijek dodaje Grease Pencil objekt nakon izrade prikaza što znači da čak i ako se linije u 3D 
prostoru nalaze iza plohe s 2D animacijom, pri izradi prikaza biti će dodan Grease Pencil 
preko 2D plohe. 

Kako bismo uklonili linije koje se nalaze iza crteža, a zadržali linije koje se nalaze ispred 
moramo upotrijebiti slojeve prikaza (engl. View Layer). Slojevi prikaza u Blenderu određuju 
što će biti uključeno u izradu prikaza. Te slojeve možemo kasnije spojiti u jednu sliku 
pomoću čvorova u Blenderovu kompozitoru (engl. Compositor). To znači da možemo 
napraviti jedan sloj prikaza koji sadržava pozadinu i jedan s pozadinskim linijama, njih ćemo 
podložiti ispod sloja koji sadržava plohu s 2D animacijom i sloja s linijama koje se nalaze 
ispred 2D animacije (slika 50). 

 

Slika 50. Raspored slojeva prikaza 

Za izradu linija na drugom sloju isključit ćemo 2D plohu s animacijom i generirati linije te 
tako stvoriti sve linije u pozadini. Na zadnjem sloju uključit ćemo plohu s 2D animacijom i 
generirati linije čime ćemo dobiti linije u prednjem planu. 

Važno je uključiti objekte koji će se pojavljivati ispred 2D animacije kao Holdout objekte u 
sloju prikaza koji sadržava 2D animaciju kako bi svi predmeti koji se nalaze ispred 2D 
animacije bili izrezani iz tog sloja (slika 50). 

Slojeve prikaza u kompozitoru možemo spojiti s pomoću Alpha Over čvora. Alpha Over čvor 
daje nam mogućnost slaganja slojeva jednog iznad drugog na sličan način kao u programima 
za 2D grafiku (npr. Clip Studio Paint, Photoshop, Krita itd.) (slika 51). 
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Slika 51. Slaganje slojeva prikaza u kompozitoru 

3.9. KOMPOZITING I IZRADA PRIKAZA 

Prije izrade završne animacije odlučila sam dodati neke efekte s pomoću Blenderova 
kompozitora kako bih još bolje udružila 2D i 3D elemente animacije.  

Dodala sam Brightness/Contrast i Add čvorove s pomoću kojih sam napravila korekciju boja 
pozadine i linija (slika 52). Glare čvor koji stvara efekt isijavanja svjetla na obasjanim 
dijelovima postavila sam nakon zadnjeg Alpha Over čvora (slika 53). 
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Slika 52. Brightness/Contrast i Add čvorovi 

 

Slika 53. Glare čvor 

Upotrebom Lens Distortion čvora stvorila sam blagi efekt kromatske aberacije. To možemo 
postići tako da označimo opciju Projector i povećamo vrijednost Dispersion. Veća vrijednost 
stvara jači efekt kromatske aberacije (slika 54). 

 

Slika 54. Lens Distortion čvor 
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Na kraju sam dodala Screen čvor s Noise teksturom kako bih dobila blagi šum preko cijele 
animacije. Šum i slične teksture često se dodaju preko digitalnih radova da bi se izbjegla 
plošnost i postigao prirodniji izgled. Pri kombinaciji 2D i 3D elemenata blagi šum može 
pomoći ujediniti izgled cijelog djela. 

 

Slika 55. Prikaz svih čvorova u kompozitoru 

Nakon kompozitinga ostala je izrada prikaza, tj. animacije. Animaciju sam izradila s pomoću 
pogona za izradu prikaza Cycles. Za ovaj oblik animacije nije potrebno imati visok broj 
uzoraka (engl. Sample) i odbijanja svjetlosti (engl. Bounce). Povećanjem uzoraka i odbijanja 
svjetlosti možemo dobiti kvalitetniji prikaz, ali će vrijeme kalkulacija pri izradi prikaza 
također biti povećano. Za izradu prikaza upotrijebila sam 15 uzoraka i opciju za uklanjanje 
šuma OpenImageDenoise. Šum nastaje kao posljedica malog broja uzoraka pri kalkulaciji 
osvjetljenja, tj. praćenja svjetlosnih zraka na kojima počiva proces Cycles pogona. Postavke 
odbijanja svjetlosti možemo vidjeti na slici 56. Pri upotrebi velikog broja ploha s prozirnom 
pozadinom u 3D sceni potrebno je povećati broj odbijanja u Transparent opciji zbog 
izbjegavanja crne pozadine na prozirnim dijelovima. 

Za šest kadrova prikazanih u ovom diplomskom radu vrijeme kalkulacije pri izradi prikaza 
trajalo je od dva do osam sati po kadru. Konačne rezultate moguće je vidjeti na sljedećoj 
poveznici: https://drive.google.com/file/d/1E5aLIHDVLPT1exVcmzN8fgWwZw88XOAC/vi
ew?usp=sharing. 
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Slika 56. Postavke uzorkovanja i odbijanja svjetlosti 
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4. REZULTATI ISTRAŽIVANJA 
 

Svrha ovoga rada bila je istražiti mogućnosti hibridne animacije, testirati proces izrade 
jednog od mnogih oblika ove animacije te iznijeti vlastito shvaćanje i tumačenje rezultata 
istraživanja. 

Trenutačno je vrlo teško pronaći informacije o ovoj vrsti animacije. Razlog tomu je 
djelomično njezina svestranost. Postoji mnogo načina kombiniranja različitih vrsta animacije, 
a kao rezultat postoji i mnogo metoda i vrsta hibridne animacije. Animatori se koriste 
prednostima svake vrste koju kombiniraju ovisno o vlastitim potrebama i željama te na taj 
način stvaraju jedinstvene kombinacije i rezultate. Neke su metode opisane u ovom radu 
dobro poznate i možemo naći mnogo njihovih primjera, no neke su metode neuobičajene. U 
literaturi i izvorima ne postoji mnogo detalja o samom procesu, pa se u nekim trenutcima 
nisam mogla oslanjati na starije primjere. Velik dio izrade ovoga rada sastojao se od raznih 
pokušaja za dobivanjem željenog rezultata. Mnogi nisu bili uspješni ili su zahtijevali 
drugačiji pristup.  

Tijekom izrade primijetila sam mnoge prednosti i mane upotrebe ove tehnike. 

Počevši s manama, za izradu ove vrste animacije potrebno je znanje o različitim vrstama 
animacije. Svaka vrsta animacije zahtijeva različiti pristup izradi. Kako bi uspješno spojili 
dvije različite vrste animacije, animatori moraju biti upoznati s obilježjima i procesom izrade 
obiju vrsta. Animatori moraju biti sposobni spojiti dva različita procesa animiranja u jedno 
stilski koherentno djelo. Prevelika stilska odstupanja između kombiniranih tehnika mogu 
odvraćati pažnju publike i izgledati nespretno. Naravno, postoje situacije kada je poželjno 
imati takva odstupanja, ali u tom slučaju to mora biti svjesna odluka umjetnika.  

Ova animacija zahtijeva i određene tehnološke mogućnosti. Mogućnosti izrade ovise o snazi 
procesora i grafičke kartice, količini RAM-a i drugim obilježjima računala koje 
upotrebljavamo. Kao što je navedeno u ovom radu, neke odluke pri izradi 3D scene bile su 
uvjetovane tehnološkim ograničenjima računala. Čak i kada mi je bilo dostupno kvalitetnije 
rješenje, ono nije bilo moguće zbog tehnoloških ograničenja pa sam morala tražiti 
jednostavnije rješenje koje nije previše utjecalo na smanjenje kvalitete. Često su ovakve 
situacije predvidive, ali sam se tijekom izrade našla i u nekoliko situacija kada su tehnološka 
ograničenja mojeg računala stvorila probleme koje nisam očekivala. Takve situacije i traženje 
alternativnog rješenja znatno su odužile proces izrade. S razvojem tehnologije ova će 
ograničenja biti sve manja i animatorima će se pružiti nove mogućnosti, no uvijek je važno 
imati na umu da bi se ovakve situacije mogle dogoditi pri izradi. 

Proces opisan u ovome radu zahtijeva znanje rada u trima različitim računalnim programima. 
Iako je tehnički moguće sve odraditi u programu Blender, dala sam prednost načinu rada u 
više programa jer mi je svaki od njih olakšao određeni dio procesa. Iako mi služenje s više 
različitih programa nije predstavljalo problem jer sam već imala iskustva s radom u tim 
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programima, takav način rada mogao bi predstavljati veliku prepreku za one animatore koji 
na to nisu navikli ili nisu upoznati s radom u određenom programu. 

Za izradu prikaza bilo je potrebno odvojiti dugo vremena. Za najkraći kadar bilo je potrebno 
odvojiti dva sata za izradu prikaza, a za najduži oko osam sati. Dodatna je mana to što 
rezultati nisu vidljivi prije same izrade, što znači da nikada nismo sigurni kako će točno kadar 
izgledati prije izrade prikaza. To može stvoriti velike probleme jer ispravljanje i najmanje 
greške može potrajati nekoliko sati. Međutim, ovaj bi problem uskoro mogao biti riješen. 
Nedavno je u Blender dodana opcija koja nam omogućava da vidimo kako će izrada prikaza 
izgledati u stvarnom vremenu bez prethodne probne izrade. Nažalost, ta opcija još nije u 
mogućnosti prikazati sve efekte koji su dodani u kompozitoru što znači da će prikaz biti 
sličniji završnom rezultatu, no određeni će dijelovi još uvijek biti vidljivi tek kada napravimo 
izradu prikaza. Ako Blender nastavi razvijati ovu tehnologiju, mogli bismo uskoro imati 
opciju točnog pregleda finalnog prikaza bez trošenja vremena na probne izrade prikaza. 

Prelazeći na prednosti ove tehnike, započet ću s prednostima upotrebe 3D kamere i 
scenografije. 3D kamera omogućuje nam dinamično kretanje u prostoru. Pomicanjem 3D 
kamere možemo dobiti dodatni osjećaj dubine prostora i stvoriti dinamične akcijske scene. U 
kombinaciji s 3D scenografijom možemo stvoriti impresivne scene u kojima se kamera i 
karakteri slobodno kreću u prostoru. Čak i kada 3D upotrebljavamo samo kao skicu, ova nam 
tehnika omogućuje da preciznije prikažemo pokret karaktera u prostoru. 

S pomoću 3D scenografije možemo znatno smanjiti vrijeme potrebno za izradu pozadina u 
onim situacijama kada se velik dio radnje odvija u istom prostoru. Ručno crtanje pozadina 
može biti brže kada se radnja odvija na više različitih mjesta i nije potrebno prikazati svako 
mjesto iz mnogo različitih kutova. No, kada se znatan dio radnje odvija na jednom mjestu 
izrada 3D prostora može pomoći skratiti vrijeme potrebno za izradu pozadina. Isto tako nam 
može pomoći u slučajevima kada je prostor vrlo detaljan i potrebno ga je prikazati u 
različitim kadrovima. U kombinaciji s 3D kamerom omogućuje nam slobodno kretanje 
karaktera i kamere u prostoru te promjenu perspektive bez nailaženja na probleme 
skraćivanja ili gubljenja iluzije dubine prostora kao što bi to bio slučaj pri upotrebi 2D ploha 
za izradu scenografije.  

Još je jedna od prednosti 3D scenografije i mogućnost simulacije različitih pozadinskih 
efekata, kao što su magla, kiša, vatra, promjene svjetla i sl. Blender nudi brojne alate za 
simulaciju različitih efekata što olakšava proces izrade scena koje bi u protivnom bile vrlo 
zahtjevne za izradu. 

Ovom tehnikom možemo i povećati razinu detalja u animaciji. Animacija metala i sjajnih 
površina vrlo je dugotrajna i skupa. Manjim timovima animatora ili samostalnim animatorima 
to stvara velike probleme jer su prisiljeni birati između kvalitete animacije i detaljnog 
prikaza. Svakim povećanjem detalja produljujemo i vrijeme potrebno za izradu svake sličice 
animacije, a time povećavamo i cijenu produkcije. Zbog toga vrlo detaljne animacije često 
imaju manji broj sličica i primjenjuju razne animacijske trikove kako bi se sakrio mali broj 
slika po sekundi. Imati visoku razinu detalja s fluidnom animacijom često nije nešto što si 
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manji timovi animatora mogu priuštiti. Navedena tehnika može pomoći riješiti ovaj problem. 
Blenderom možemo programirati sjenčare tako da simuliraju razne materijale na različitim 
dijelovima 2D crteža. Na taj način možemo dobiti višu razinu detalja za kratko vrijeme. Tom 
tehnikom možemo izraditi razne teksture na odjeći karaktera, odsjaje na metalu i glatkim i 
sjajnim površinama, dodati dijelove koji svijetle itd. 

Još je jedna prednost i mogućnost ponovne upotrebe svih 3D elemenata. Objekti koje smo 
izradili mogu se kopirati i upotrijebiti za izradu drugog prostora. Materijali koje smo dodali 
na 2D crtež mogu se lako prenijeti i na druge crteže te mijenjati po potrebi. Npr. ako smo već 
izradili materijal koji oponaša odsjaje na metalnim površinama, taj isti materijal možemo 
primijeniti na svaki crtež ili dio crteža na kojem nam je potreban te mu mijenjati sjaj, boju i 
druga obilježja na vrlo jednostavan i brz način. Kada bismo to radili ručno, morali bismo 
ponovno crtati te odsjaje na svakom crtežu koji sadržava metalne dijelove. 

Ovo se istraživanje odvijalo u razdoblju od petnaest mjeseci, od kojih je izrada sinopsisa 
trajala tri dana, izrada model-liste i knjige snimanja četiri mjeseca, 3D scenografije osam 
mjeseci, 3D skice za animaciju jedan mjesec, 2D animacije tri mjeseca, dok je jedan mjesec 
trajalo ubacivanje 2D animacije u 3D scenu, uređivanje materijala na 2D animaciji i 
kompoziting. Neki dijelovi procesa odvijali su se istodobno. Sada kada sam upoznata s 
procesom, za ponovno ostvarenje ovih rezultata bilo bi potrebno manje vremena. 3D 
scenografija mogla bi se izraditi u roku od četiri mjeseca ili manje. Izrada 3D skica i 2D 
animacije zahtijevala bi slično razdoblje. Izrada 3D materijala za 2D animaciju i kompoziting 
zahtijevali bi jedan ili dva dana. 

Ovaj oblik hibridne animacije donosi mnogo mogućnosti i može služiti kao vrijedan alat 
mnogim animatorima. Vjerujem da će s razvojem tehnologije ovaj proces postati još 
jednostavniji i pristupačniji velikom broju ljudi. Eksperimentiranje s hibridnom animacijom 
može nas potaknuti da razmišljamo izvan okvira onoga što nam je poznato i na taj način 
pronađemo nova rješenja koja nam mogu pomoći u ostvarivanju naše umjetničke vizije. 
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5. ZAKLJUČAK 
 

Hibridna animacija vrsta je animacije koja otvara vrata mnogim novim kreativnim rješenjima. 
Danas je sve češće u upotrebi i možemo pronaći niz kvalitetnih filmova i serijala koje 
upotrebljavaju ovu vrstu animacije. Ti primjeri i osvrti njihovih autora pomažu nam razumjeti 
prednosti i mane navedene vrste animacije te nas potiču da razmišljamo izvan okvira onoga 
što nam je poznato.  

Cilj ovoga rada bilo je istraživanje hibridne animacije. Inspirirana tim brojnim primjerima, 
htjela sam i ja istražiti njezine mogućnosti. Tijekom izrade ovoga rada nailazila sam na 
mnoge prepreke, a rješenja često nisu bila lako dostupna ili jasno objašnjena. Neke tehnike 
opisane u ovom radu već su duže vrijeme u upotrebi i nalazimo brojne izvore koji nam 
pomažu pri njihovoj izvedbi. Međutim, neke tehnike ne pronalazimo često. Za te dijelove 
nisam mogla pronaći literaturu koja bi mi služila kao vodič u izradi te sam morala raditi 
vlastite eksperimente i tražiti rješenja. Ovaj rad opisuje samo dio cjelokupnog istraživanja 
koje sam provela, prikazan je onaj dio procesa koji je donio zadovoljavajuće rezultate. 
Vjerojatno postoje kvalitetnija i brža rješenja od onih prikazanih u ovom radu, no za njihov 
pronalazak biti će potrebno provesti daljnje eksperimente.  
  



43 
 

6. LITERATURA 
 

1. Blender Documentation Team. 2023. Blender 3.5 Reference Manual. Blender Foundation. 
https://docs.blender.org/manual/en/3.5/index.html (pristupljeno 24. lipnja 2023.). 

2. Formenti, Cristina. 2021. KRISTIAN JARED ROBINSON – BETWEEN A “ROCK” AND 
A HARD PLACE: THE HYBRIDIZATION OF ANALOG AND DIGITAL IN THE IRON 
GIANT. https://journal.animationstudies.org/between-a-rock-and-a-hard-place-the-
hybridization-of-analog-and-digital-in-the-iron-giant/ (pristupljeno 24. lipnja 2023.). 

3. Marušić, Joško i suradnici. 2004. Alkemija animiranog filma. Meandar. Zagreb. 
4. kViN. 2017. LAND OF THE LUSTROUS / HOUSEKI NO KUNI PRODUCTION NOTES 

1-6. https://blog.sakugabooru.com/2017/11/15/land-of-the-lustrous-houseki-no-kuni-
production-notes-1-6/ (pristupljeno 25. lipnja 2023.). 

5. O'Hailey, Tina. 2010. Hybrid Animation Integrating 2D and 3D Assets. Focal Press. 
Burlington. 

6. Snyder, Chris i Desiderio, Kyle. 2021. 'Wolfwalkers' is nominated for animated feature 
film at the Oscars. Here's how the film used 3D technology to transform 2.5D animation. 
https://www.insider.com/how-wolfwalkers-used-3d-tech-to-transform-25d-animation-
2021-2 (pristupljeno 12. lipnja. 2023.). 

  

https://docs.blender.org/manual/en/3.5/index.html
https://journal.animationstudies.org/between-a-rock-and-a-hard-place-the-hybridization-of-analog-and-digital-in-the-iron-giant/
https://journal.animationstudies.org/between-a-rock-and-a-hard-place-the-hybridization-of-analog-and-digital-in-the-iron-giant/
https://blog.sakugabooru.com/2017/11/15/land-of-the-lustrous-houseki-no-kuni-production-notes-1-6/
https://blog.sakugabooru.com/2017/11/15/land-of-the-lustrous-houseki-no-kuni-production-notes-1-6/
https://www.insider.com/how-wolfwalkers-used-3d-tech-to-transform-25d-animation-2021-2
https://www.insider.com/how-wolfwalkers-used-3d-tech-to-transform-25d-animation-2021-2


44 
 

7. PRILOZI 

7. 1. RJEČNIK 

1. ANIMACIJA 
1.1. Hibridna animacija (engl. hybrid animation) – vrsta animacije koja kombinira dvije ili 

više različitih vrsta animacije. 
1.2. Knjiga snimanja (engl. storyboard) – vizualna reprezentacija scenarija u obliku niza slika 

na temelju kojeg se izrađuje film. 
1.3. Model-lista (engl. model sheet) – prikaz dizajna, tj. vizualnog rješenja elemenata filma 

kao što su karakteri i pozadine. 
1.4. Ključna poza (engl. keyframe) – ključni crteži koji definiraju pokret. 
1.5. Faza (engl. in-between) – crteži koji se nalaze između ključnih poza. 
 
2. BLENDER 
2.1. Modifikator (engl. Modifier) – automatske operacije koje mijenjaju 3D objekt na 

nedestruktivan način. 
2.2. Vrh (engl. Vertex) – točka u 3D prostoru, sastavni dio mreže virtualnog 3D objekta. 
2.3. Brid (engl. Edge) – ravna linija koja spaja dva vrha, sastavni dio mreže virtualnog 3D 

objekta.  
2.4. Poligon (engl. Face) – ploha omeđena bridovima, sastavni dio mreže virtualnog 3D 

objekta. 
2.5. 3D mreža (engl. Mesh) – sastoji se od vrhova, bridova i poligona koji čine virtualni 3D 

objekt. 
2.6. Zaglavlje (engl. Header) – vodoravna traka koja se nalazi iznad ili ispod okvira, sadržava 

razne opcije, izbornike, alate i sl. 
2.7. Objektni način rada (engl. Object Mode) – zadani način rada, omogućuje promjenu 

položaja, rotacije i veličine cijelog 3D objekta i druge naredbe, ovisno o vrsti 3D objekta. 
2.8. Uređivački način rada (engl. Edit Mode) – način rada koji služi za uređivanje elemenata 

objekta, ovisno o njegovoj vrsti. 
2.9. Izrada prikaza (engl. Render) – proces izrađivanja 2D slike od 3D scene. 
2.10. Sjenčar (engl. Shader) – programski kod koji određuje izgled 3D objekta tijekom 

procesa izrade prikaza. 
2.11. Čvor (engl. Node) – Moduli različitih funkcionalnosti koji se upotrebljavaju prilikom 

vizualnog programiranja.  
2.12. Razmatanje 3D mreže (engl. UV Unwrapping) – proces kreiranja UV mape, tj. 

razmatanja mreže objekta na 2D plohu. 
2.13. UV mapa (engl. UV Map) – plošna, dvodimenzionalna reprezentacija površine 3D 

objekta. 
2.14. Kolekcije (engl. Collections) – Grupe koje sadržavaju objekte u sceni, upotrebljavaju se 

za organiziranje scene. 
2.15. Kostur (engl. Skeleton) – sastoji se od virtualnih kostiju i služi za animiranje objekata. 
2.16. Težina (engl. Weight) – određuje koliki će utjecaj pojedina kost imati na određeni dio 

mreže objekta (grupu vrhova). 
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2.17. Dodatak (engl. Add-on) – sekundarne skripte koje proširuju funkcije programa, daju mu 
nove mogućnosti ili pojednostavljuju rad u programu. 

2.18.  Grupa vrhova (engl. Vertex Group) – sadržava više vrhova, može se upotrebljavati za 
animaciju, ograničavanje modifikatora na dio mreže koji sadržava vrhove iste grupe, 
fizičke simulacije, itd. 

2.19. Ključna poza (engl. keyframe) – promjene objekta, čvora ili modifikatora koje su 
upisane na vremensku crtu. 

2.20. Vremenska traka (engl. Timeline) – traka koja prikazuje određeno vremensko trajanje, 
sadržava ključne poze za sve animirane objekte u sceni. 

2.21. Akcija (engl. Action) – blok podataka koji sadržava informacije o animaciji spremljene 
u obliku ključnih poza na vremenskoj traci. 

2.22. Karton snimanja (engl. Dope Sheet) – tablica koja prikazuje ključne poze u sceni; u 
računalnoj animaciji također prikazana kao oblik vremenske trake. 

2.23. Izlazne postavke (engl. Output Properties) – postavke koje određuju oblik u kojem će 
rezultat izrade prikaza biti spremljen. 

2.24. Gornja traka (engl. Topbar) – vodoravna traka koja se nalazi na vrhu prozora programa. 
2.25. Rubno svjetlo (engl. Rim light) – svjetlo postavljeno iza objekta koje obasjava rub ili 

obris objekta. 
2.26. Sjenčarski čvor (engl. Shader node) – vrsta čvora u sjenčaru, određuje kakvu će 

interakciju svjetlo imati s površinom 3D objekta. 
2.27. Slojevi prikaza (engl. View Layer) – slojevi za izradu prikaza, upotrebljavaju se na 

sličan način kao i slojevi u programima za 2D grafiku. 
2.28. Kompozitor (engl. Compositor) – sučelje za kompoziting slike s pomoću čvorova u 

Blenderu koji dodaju razne efekte na rezultat izrade prikaza. 
2.29. Uzorci (engl. Sample) – broj svjetlosnih uzoraka po pikselu prilikom računanja fizički 

korektnog prikaza osvjetljenja 3D scene. 
2.30. Odbijanje svjetlosti (engl. Bounce) – broj odbijanja svjetlosnih zraka prilikom 

računanja fizički korektnog prikaza osvjetljenja 3D scene. 
 
3. CLIP STUDIO  
3.1. Sloj (engl. Layer) – prozirni slojevi ili listovi na koje možemo slikati i slagati ih jedne na 

druge. 
3.2. Rasterski sloj (engl. Raster layer) – sloj koji sadržava rasterski crtež. 
3.3. Vektorski sloj (engl. Vector layer) – sloj koji sadržava vektorske krivulje. 
3.4. Vremenska traka (engl. Timeline) – traka koja prikazuje određeno vremensko trajanje, 

sadržava mape za animaciju i sličice animacije. 
3.5. Sličica animacije (engl. Animation cel) – sličice koje čine animaciju, dodaju se na 

vremensku traku odabirom opcije New animation cel. 
3.6. Mapa za animaciju (engl. Animation folder) – mapa koja sadržava slojeve za animaciju. 
3.7. Izvoz (engl. Export) – prijenos podataka u drugi format. 
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